agre % TRONIA

SYSTEMS

AR INVOICE DISCOUNT PRODUCTS

Invoice
TSL Custom Ag & Terminal Inc. - Edmonton .
24715 Yellowhead Trail West Ref No: EINV373
Edmonton, Alberta TGR 7L4 Date: Apr 13,2023
Ph:780.466.1273Fax. 780.465.1273 TollFree:800.555.1212
Sold To: James Abraham (0190) Page: 1of 1
PO Box 12
Westlock, AB TOK 2L5 T780-466-2345
Ref No Quantity  Unit Description GST Unit Price Amount
6 Case Achieve Liquid Gold M §776.00 $4,656.00
Lot#: 150503
15 % Volume Discount 15% ¥ %4 656.00 (5695.40)

Products flagged as Discount Products can be added to AR Invoices to discount one
product, a product subtotal, the entire invoice, or any combination thereof.

Invoice Discount Products do not change the price and have no effect on product cost,
therefore they have no effect on product margins.

Taxes and products flagged as Exclude From Invoice Discounts cannot be discounted.

What you’ll find:

Last Updated: 2023.07.06



Setup

Company Config Options

Enable Discount Products for invoices must be checked.

% Company Level Settings
= save | € Ext
General]  Accounts Receivable l Blending l Accounts Payable ] General Ledt

Invoices ] Loadout Tickets l Work Orders l AR Release Mo ] AR Payments

¥ Automatically generate Reference Number
3 WO Taxes on Invoice
Enable Discount Products

File > Config Options > Company / Accounts Receivable / Invoices

Once any discount product has been used on an invoice, the config option should not be
unchecked until all fiscal years with invoice discount products have been closed (deactivate
the discount products in the meantime so they cannot be added to any new invoices).

Discount Products

All invoice discount products are non-inventory items.
The setup for each type is very similar, with just a different Discount Type selected.

A default discount percentage can be specified (which can be changed on each invoice) or
default percentage can be left blank and entered manually on each invoice.

AR Invoice Discount Product Business Rules

Discount checkbox available for non-inventory products only.
Once discount product has been used, checkbox is disabled.

Default Discount % is optional, but if entered
e must be positive

e cannot exceed 100%

e isjust a default, can be changed on invoice

Taxes and products flagged as Exclude From Invoice Discounts are not discounted
Product Subtotal discount product cannot follow a Product Row discount product

Invoice Discount Products cannot be an added to the Additional Products tab
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Product Row Discount Products

A Product Row discount is based on the line total amount of the product row directly above

it.
Invoice
TSL Custom Ag & Terminal Inc. - Edmonton .
24715 Yellowhead Trail West Ref No- EINV378
Edmonton, Alberta TGR 7L4 Date: May 25, 20232
Ph: 780 466 1273Fax: 780 4651273 Toll Free: 800.555.1212 '
Sold To: James Abraham (0190) Fage:1of 1
PO Box 12
‘Westlock, AB TOK 3L5 780-466-2345
Ref No GQuantity Unit Description GST Unit Price Amount
6 Case Achieve Liquid Gold N S776.00 §4,656.00
Lo# 150601-3 /
10 % Product Row Discount 10% M 54, 656.00 ($465.60)
example of a Product Row discount
discount product Unit Price = Amount of previous product row
On the Product tab
¥ Edit Product: DISCPRODROW10 - Product Row Discount 10% =N
= S&i Refresh | X Delete 5.::{ Prices/Taxes | €3 Exit
Product l Units ] In\tentory] Notes ] Associated Products ] Blending ] Manufacturing ] Dangerous Goods ] Regulations ] Grower Central ]
This product is active. ) - ¥ Retumablz?
use a naming
Product Code: |D|SCPRODROW1D | convention for faster ™ Blendable? I Prohibit Purchase?
Dlescription: Product Row Discount 10% | selection on invoices [~ Manufactured? [ Exclude From AgCollect?
| _
Short Desc: | | {Eg DI’EﬂX B DlSC) [ Dangerous Good? ¥ Ovenidable Sales Accourt?
d
= Froduct Type: |Chen1icals (34539) -~ Add [~ Omit From Sales Reports? ™ Exclude From Discourt Groups?
UPC Code: | I~ Lot Number Required?
Default Project: | j Add |
Yals
Manufacturer: | j —Discounts optional
Manuf. Prod. Code: | 7\\(/ Discount Type: Discount % ™
Discount  |Product Row j * |1D A
—
GL Accounts Product Characteristics ada"m_c? a Commo{l
characteristic makes discounts
_h | Sales: |EZ'I 00 - Sales Discounts j* Charactenistics easy to select on r'epor'ts.f
COGS: | =] =
Inventory: | J ¥ Add Product Characteristic
Inv. Accrual: | J n Gave '@ Ext
Add GL Account
Characteristic Description: |Discoums|

Inventory > Manage > Products
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Inventory Item: must be unchecked

Product Code: consider a naming convention that allows you to quickly find and add
discount products to invoices

o specific e.g. DISCOUNT10
o tip: set the Discount % to 10 so a 10% discount is calculated by default
(shown above)

e generic e.g. DISCOUNT
o tip: leave the Discount % blank and agré will default to 0% so you can set it to
the percentage applicable to each invoice (with a popup reminder on save if
you forget to change it)

Description: appears on the invoice

Product Type: can be a regular product type, or a separate Discounts product type; think
about how you currently run reports by product type and where you want discounts to fit in

Sales GL: discounts can be recorded as an Expense (6-9 account), an increase to COGS
(5 account), or as negative Revenue (4 accounts); your accountant may have a preference

Discounts: box must be checked; select Product Row from Discount Type drop down;
optionally enter a default % (can be changed on each invoice if needed)

Characteristics: (optional) adding a common characteristic to all your discount products
gives you another way of filtering report results

On the Units tab:

% Edit Product: DISCPR10 - Previous Row Discount 10% =N E=R ="
= save Refresh | # Delete -‘3 Prices/Taxes | &3 Exit

setup Unit Type the

way you want to see it
Units Main Upis? Company Retail Price , .
= \’\f on the invoice report!

Product Units ]Inverrtc-ry] Notes ] Associated Produ-:ts] Blending] Manufacturing Dangemu(

-

Add Units ,_. \ 3 - i

i
[}

%7 Add Product Unit . *
[ save | €9 Bt '_."
[ ' f
displays on report = it Code:  °
- Unit Description: |PEHCENT| *

Inventory > Manage > Products

Units: select the unit type that is setup the same way you want to see it displayed on the
invoice report

Company Retail Price: ignored, can be left blank
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Product Subtotal Discount Products

Product Subtotal discount products are based on the line total amount of all product rows
above it (up to another discount row).

g Invoice
TSL Custom Ag & Terminal Inc.- Edmonton .
24715 Yellowhead Trail West Ref No: BINV373
Edmaonton, Alberta TER 7L4 Date:Apr 11, 2023
Ph:780.466.1273Fax: 780.465.1273 Tell Free:800.555.1212
Sold To: James Abraham {0190) Page: 1 of 1
PO Box 12
‘Westlock, AB TOK 3L5 780-466-2345
Ref No Quantity Unit Description GST Unit Price Amount
G Case Achieve Liguid Gold M $776.00 $4 656.00
LoB#:150503-2
-4% x ($4656 + $560) | 80 Acre Customn ApplicationFees N §7.00 $560.00
=-$208.64 4 9 Product Subtotal Discount N $5,216.00 (5208.64)
- 2 Case BUCTRIL M N §970.00 §1,940.00

example of a Product Subtotal discount on the 2 products above it

Setup the same as for Product Row, but on the Products tab select Product Subtotal as the
Discount Type

¥ Edit Product: DISCPRODSUB - Product Subtotal Discount =N
H sqve Refresh | & Delete Lf{ Prices/Taxes | €3 Exit

Product l Units ] In\tentory] MNotes ] Associated Products ] Blending ] Manufacturing ] Dangerous Goods ] Regulations ] Grower Central ]

This product is active. - ¥ Retumable?
Product Code:  |DISCPRODSUB =

I Prohibit Purchase?
7 [ Exclude From AgCollect?

Description: |Product Subtotal Discount once saved on an invoice, Discount

Short Desc: | Type cannot be changed! ood? I™ Ovenidable Sales Accourt?
Product Type: |Chen1icals (34539) — ales Reports? ™ Exclude From Discourt Groups?
UPC Code: | ~a ‘ ™ Lot Number Required?

. l
Default Project: | | Add ”;_—»‘:.: ~
Manufacturer: | j “\/'/ Dizcounts
Manuf. Prod. Code: | Discount Type: Discount %

[Product Subtotal ] ~| 4

- T

Inventory > Manage > Products
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Invoice Total Discount Products

Invoice Total discount products are based on the discounted line total Amounts of all product
rows on the invoice.

agre

TSL Custom Ag & Terminal Inc.- Edmonton
24715 Yellowhead Trail West

Invoice

Ref No:EINV3T73

Edmaonton, Alberta TGR 7L4 Date: Apr 11, 2023
Ph:780.466.1273Fax: 780.465. 1273 Toll Free: 800.555.1212
Sold Te: James Abraham (0190) Page:1of 1
PO Box 12
Westlock, AB TOK 3L5 780-466-2345
Ref No Quantity  Unit Description GST Unit Price Amount
6 Case Achieve Liquid Gold M $776.00 54,656.00
Lot# 150503-2
80 Acre Custom Application Fees M $7.00 $560.00
4 o Product Subtotal Discount M $5,216.00 ($208.64)
2 Case BUCTRIL M M $970.00 51,940.00
2 % Invoice Total Discount M 56,947.36 (5138.95)

Invoice Discount = -2% x (-4% x ($4656 + $560) + $1940) =-$138.95

example of a 4% Product Subtotal discount on 2 products combined with a 2% Invoice Total discount on all

Same as for Product Row, but on the Products tab select Invoice Total as the Discount
Type

+ Edit Product: DISCINV - Invoice Total Discount [ ==
= shve Refresh | X Delete !.:3 Prices,/ Taxes | €3 Bt

Product ]Un'rts ] In\rentory] Motes ] Associated Products] Blending] Manufacturing | Dangerous Gocds] Regulations | Grower Cermal]

This product is active. I ¥ Retumable?
Product Code:  [DISCINV i [ Blendable? I Prohibit Purchass?
Description: |Inv0ice Total Discourt N I Manufactured? ™ Exclude From AgCollect?
Short Desc: | ™ Dangerous Good? [~ Ovemidable Sales Accourt?
Product Type: |Chemic:a|s (34539) j i Add ™ Omit From Sales Reports? ™ Exclude From Discount Groups?
UPC Code: | ™ Lot Number Required?
Default Project: | | Add r
Manufacturer: | j Discounts
Manuf. Pred. Code; | ﬁJ Discount Type: Discount %

Discoun| |Inv0ice Total j' IZ =

Inventory > Manage > Products
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Deactivating Discount Products

Deactivate discount products that are no longer in use.
Deactivated discounts cannot be added to transactions.

Ones already on existing transactions will not be affected but cannot be edited.

¥ Manage Products = E=h =
=+ Add f Edit | X Delete | dth New Search l@ Deactivate E'Eu Copy 53‘{ Prices/Taxes E Price Check Histaory 6 Exit
Product Code = | Description Product Type Active?
DISCPRODROW Product Row Discount Chemicals &
S DISCPRODROWIO  Prodet Row Discout 10%
DIsg===maes . - S
Cenfirm Action

3 Product]

"\-.I Are you sure you want to deactivate Product Row Discount 10%? This

' change will take effect immediately.

Proceed?

Inventory > Manage > Products

Products That Should NOT Be Discounted

If you have products that are never eligible for AR Invoice Discounts (like a container

deposit), flag them as Exclude From Invoice Discounts.

+ Edit Product: DISCEX - Excluded AR Invoice Discounts
E Save Refresh X Delete g{ Prices,/Taxes ‘3 Exit

Product l Units ] In\rentory] Motes ] Associated Products ] Blending ] Manufacturing | Dangerous Goods ] Regulations ] Grow

This product is active. ¥ Invertory ttem?

Lo 5 s

er Central ]

v Retumable?

[ Prohibit Purchase?

™ Exclude From AgCollect?

=

[+ Exclude From Discount Groups?

™ Lot Number Required?

Product Code: |D|SCEX i [ Blendable?

Description: |Exc|uded AR Invoice Discourts ' [ Manufactured?

Short Desc: | ™ Dangerous Good?
ProductType:  [Chemicals (234539) =" add [ Omit From Sales Reports?

UPC Code: | Q'/

Default Project: | ﬂ Add W' Exclude from Invoice Discounts?

Inventory > Manage > Products

The Inventory Product List data export identifies which products are flagged as excluded.

> Product List
€Q Bt

Simple ] Advanced ]

Blendable Active J Excclude Discoul Lot Required | Dangerous Goo| EPD

Na Yes No flo No No

Ne Yes Yes o N Mo

No Yes Yes hlo No No
i

File > Exports > Data

AR Invoice Discount Products
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Adding Discount Products to Invoices

e Add or Edit an invoice.

o Add or Import the product(s) to be discounted.

Adding Product Row Discount Products:

Purchases Tab

¢ The Quantity defaults to the % on the Product tab (can be changed)

¢ The Unit Price defaults to the line total from the product row above and cannot be
changed

e The Line Total (discount amount) is calculated and cannot be changed
= Quantity % / 100 * Unit Price * -1

</ Add Invoice
n Save Refresh Split |}, Documents 5§i View Credit View Prepayment View WO Activity '@ Exit

Reference: * |V Generate Reference Automatically T ion: Edmon

Customer: |Ablaham.James (0150) ﬂ. Find Add Created By: |aore U
Invoice Date: |Jun 16, 2023 -1 Due Date: | Jun 26, 2023 -|" Invoice

Customer and Shipping  Purchases (1) ] Retums l Totals l Immediate Payment ]

Product Quantity Unit Price Taxes Line Total | Prepay? | Hold? |Lc
> |ACHIEVE - Achieve Liguid Gold (CASE) 6.0 5776.00 £0.00 $4,656.00 [E E
& Add Invoice Purchase Row *

@ Update Refresh | €3 Exit

Purchases Subtotal (be Product: |F‘r0duct Row Discount 10% - DISCPRODROW ﬂ 1 = Fow

Prepaid Purchases (bef  Lnits: |PEF~!CENT- %

0 Lirk
Prepayment Remaining| Location: |Edm0r|t0n _J 2 r

Quantity: 100 %~

Unit Price: $4.656.00 -

Line Total: -3465.60

Line Comments:

Accounts Receivable > Invoices / Add Product

AR Invoice Discount Products Page 8 of 12



What happens when a Discount Product is selected?

¢ Quantity on Hand, Details, Bill and Hold, Prepay, Pricing are hidden
¢ Quantity defaults to Product Discount % (if null, defaults to 0% and must be changed)
¢ Quantity % cannot exceed 100

¢ Unit Price defaults to the Line Total of last product row (without taxes) and is not
editable

¢ Row Sorting buttons are disabled

e Split invoice button is disabled

Totals Tab
o the Totals tab displays the purchases, returns, and discounts
& Add Invoice E@
H Save Refresh Splt | '} Documents \'s:! View Credit View Prepayment View WO Activity @ Bt
Reference: * ¥ Generate Reference Automatically Pocation: |E,:|mgmgn j
Customer: |P'blaharn. James (0190) j " Find Add Created By: |Elgre User

Jun 29, 2023 7 Invoice Total: £4.190.40

Immediate Payment ]

Invoice Date: |Jun 15, 2023 -|" Due D&

Customer and Shipping ] Purchazes {2}] Retums

Tax Summary Invoice Totals
Tax Amount Invoice Purchases Total: £4,656.00
Invoice Returns Total: £0.00
Invoice Discounts Total: (2465.60)
Tax Total: £0.00
Invaoice Total: $4,190.40

Early Payment [isrounts

e Save and preview the invoice

Invoice
TSL Custom Ag & Terminal Inc. - Edmanton .
24715 Yellowhead Trail West Ref No:EINV3T7S
Edmonton, Alberta TGR 7L4 Date: May 25, 2023
Ph: 780466 1273Fax:780.465.1273 Toll Free: 800.555.1212 '
Sold To: James Abraham (0190} Page: 1 of 1
PO Box 12
Westlock, AB TOK 3L5 T80-466-2345
Ref No Quantity Unit Description GST Unit Price Amount
6 Case Achieve Liquid Gold M S776.00 54,656.00
iR ‘/'
10 % Product Row Discount 10% M 54 656.00 (F465.60)

o

invoice with a Product Row discount
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Adding Product Subtotal Discount Products

e The Quantity defaults to the % on the Product tab (can be changed).

o The Unit Price defaults to the subtotal of the product rows above (up to a previous
discount row) and cannot be changed.

e The Line Total (discount amount) is calculated and cannot be changed.

&/ Add Invoice
n Save Befresh Split

Reference: * |V Generate Reference Automatically

|Ab|ahan1. James (0150) ﬂ " Find Add Created By |;gre Use
Invoice Date: |Jun 16, 2023 - Due Date:  |Jun 26, 2023 ~|" Invoice T

Customer and Shipping PUFChEISBS{Z}I Retums ] Totals ] Immediate Payment ]

5;:3 View Credit View Prepayment View WO Activity ‘3 Exit

I.. Documents

Location: |-Edm-:-';: N

Customer:

Product Quantity Unit Price Taxes —I.me-'l:da-l-r Prepay? | Heold? |Locst
> |ACHIEVE - Achieve Liquid Gold [CASE) 6.0 S776.00 £0.00 4 656.00 | Edme
CUSTAPP - Custom Application Fees (AC) 80.0 £7.00 £0.00 $560.00(| [ Edme
& Add Invoice Purchase Row x
& Update Refresh | €3 Exit

Purchases Subtotal (before . [
: Product Subtotal Discount - DISCPRODSUB f - i e
Prepaid Purchases (before Froduct | rocuet SLBietal Hseou J Find J Link to
Prepayment Remaining: Units: |PEHCENT - =
Location: |Edmortton $4,656.00 L
+ 5560.00
Quantity: 40% = 55,216.00
Unit Price: $521600 = | X —
= 5208.64
Line Total: -5208.64

Accounts Receivable > Invoices / Add Product

agre

T5L Custom Ag & Terminal Inc.- Edmonton
24715 Yellowhead Trail West

Edmonton, Alberia TGR 7L4
Ph:780.466 1273Fax 780 4651273

Invoice

Ref Mo: EINV3E0

Date:Jun 16, 2023
Toll Free: 800.555.1212

Sold To: James Abraham (0190) Page: 1 of 1
PO Box 12
‘Westlock, AB TOK 3L5 780-466-2345
Ref No Quantity Unit Description GST Unit Price Amount
6 Case Achieve Liguid Gold M $776.00 $4,656.00
30 Acre Custom ApplicationFees $7.00 $560.00
4 % Product Subtotal Discount M $5,216.00 ($208.64)

e - e, T

invoice with a Product Subtotal discount

AR Invoice Discount Products
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Adding Invoice Total Discount Products

e The Quantity defaults to the % on the Product tab (can be changed).

o The Unit Price defaults to the subtotal of all product rows and cannot be changed.

¢ The Line Total (discount amount) is calculated and cannot be changed.

< Add Invoice
E Save Refresh Split

i Documents

Reference: -

45 View Credt

[+ Generate Reference Automatically

Customer: |:’-".bl‘clham. James (0150)

Invoice Date: |Jun 16, 2023 ~|"

Customer and Shipping  Purchases (4) l Retums ] Totals ] Immediate Payment ]

Due Date:  |Jun 26, 2023 -

~|" Fing Add

View Prepayment View WO Activity 6 Exit

Location:

|TEdm-: ritar

Created By: |;gre Use

Imvoice

Product Quantity Unit Price Taxes Line Total | Prepay? | Hold? |Locs
ACHIEVE - Achieve Liguid Gold (CASE) 6.0 S776.00 <0.00 $4,656.00 & Edm
CUSTAPP - Custom Application Fees (AC) 2800 £7.00 50.00 $hE00D| [ Edm
DISCPRODSUB - Product Subtotal Discount (F 40 $5,216.00 <0.00 ($208.64) & Edm
= |BUCTRIL - BUCTRIL M (CASE) 20 £570.00 50.00 sisdnon| [0 Edm
&/ Add Invoice Purchase Row X
Purch Subtotal (b . d Row
urchases Subtotal ( © Updaie Befresh ‘:’ Ext
Prepaid Purchases (be Link to
Frepayment Remainin: Product: ||nv0ice Total Discount - DISCINY j ) Find
Units- |PERCENT- % ~|" —_
Location: |Edmontan ~|"
Quantity: 20%"
Unit Price: $694736 =
Line Total: $138.95
Line Comments:
Accounts Receivable > Invoices / Add Product
g Invoice

TSL Custom Ag & Terminal Inc. - Edmonton

24715 Yellowhead Trail West
Edmonton, Alberta TER 7L4
Ph:780.466.1273Fax: 780.465.1273

Toll Free: 800.555.1212

Ref No: EINV3E1

Date:Jun 16, 2023

Sold To: JamesAbraham (0190) Page:1of 1
PO Box 12
Westlock, AB TOK 3L5 T80-466-2345
Ref No Quantity  Unit Description GET Unit Price Amount
. - 4,656.00
6 Case Achieve Liquid Gold §776.00 54 656.00
o + 560.00
80 Acre Custom ApplicationFees - 5216.00 $7.00 $560.00
4 o Product Subtotal Discount less 4% (208.64] $5,216.00 ($208.64)
2 Case BUCTRIL M = 500736 5970.00 51,940.00
LS Invoice Total Discount +  1,540.00 $6,947.36 ($138.95)
= 694736
less 2% {138.95])
6,808.41 Subtotal $6,808.41
Total $6,808.41

example of Product Subtotal discount + Invoice Total discount

AR Invoice Discount Products
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Invoice Total discounts can be used in conjunction with Product Row and Product Subtotal

discounts.

£ Add Invoice

n Save Refresh Splt | . Documents -'ﬁ View Credit View Prepayment View WO Activity 6 Exit

Reference: * ¥ Generate Reference Automatically

Customer:  |Carter, Alexander (C0874)

Invoice Date: |Jun 19,2023 = |~ Due Date: |Jul 19,2023 =

Customer and Shipping Purchases (7) ] Retums ] Totals ] Immediate Payment ]

ACHIEVE - Achieve Liquid Gold (CASE)
DISCPRODROW10 - Product Row Discount 10
DEPOSIT - Deposit (EA)

CUSTAPP - Custom Application Fees (AC)
DISCPRODSUE - Product Subtotal Discount (F
BUCTRIL - BUCTRIL M {CASE)

> | InvoiceTotalDiscount - InvoiceTotal Discount |

Product Quantity

[E=8(E=E =5
Location:  |Dog River ~|"
~|" Find Add Created By: [agre User
: Invoice Total: $6.599.24

Qty Unit Price Line Total

Unit Price Taxes Line Total| Achieve 6 5$776.00 54,656.00 LOT Ref
$776.00 $0.00 $4656.00| Disc Row 10% $4,656.00 [5$465.60)
$4,656.00 $0.00 ($465.60) = 54,190.40
$0.50 $0.00 $3.00| peposit 6 $0.50 n/fa
$7.00 $61.60 $621.60 CustApp 20 47.00  $560.00
$560.00 $0.00 (82240)| pisc Sub 4% $560.00  ($22.40]
$970.00 $0.00 $1,940.00 = $4.728.00
FESH I (5133.38) | Byyctril 2 $970.00 $1,940.00

Purchases Subtotal (before tax): $6,537.64
Prepaid Purchases (before tax): $0.00
Prepayment Remaining: $217,500.96

= $6,668.00 .
_ AddProductRow | piceiny 2% $6,668.00 (5133.36) um o

Import from WO/LOT

ng Prepayment

"~ flagged as Exclude From Invoice Disc
taxes excluded from discount

example of Product Row discount + Subtotal discount + Invoice discount

What about returns?

Discount Products must be 'returned’ manually even if using the Return Invoice Process.

e e.g. purchase of 6 cases qualifies for a 10% discount

e customer purchases 6 cases and receives the discount

e customer later returns 1 case

e does the customer have to return 1/6% of the discount?

e does the return of 1 case require the return of the entire discount?

e maybe it depends?

e intervention is needed from you (the smart human) to determine how much, if any, of
the discount must be deducted

o if the discount must be ‘returned’ in part or in full, add the discount product manually to

invoice returns tab

e discount is subtracted from the amount returned

AR Invoice Discount Products
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